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About this Manual
The first part of this manual describes how to install and set up your DT8824 or DT8824-HV 
instrument module, and verify that the instrument module is working properly.

The second part of this manual describes the features and capabilities of the DT8824 and 
DT8824-HV instrument modules using the IVI-COM driver software. Troubleshooting 
information is also provided.

Note: If you are programming the DT8824 or DT8824-HV using the IVI-COM driver, refer to 
the DT8824 IVI-COM driver online help for more information.

If you are using Standard Commands for Programmable Instruments (SCPI) to program the 
DT8824 or DT8824-HV, refer to the SCPI Programmer’s Manual for the DT8824 for more 
information.

Intended Audience

This document is intended for engineers, scientists, technicians, or others responsible for 
using and/or programming the DT8824 or DT8824-HV instrument module for data 
acquisition operations. It is assumed that you have some familiarity with data acquisition 
principles and that you understand your application.

How this Manual is Organized

This manual is organized as follows:

• Chapter 1, “Overview,” describes the major features of the DT8824 and DT8824-HV 
instrument modules, as well as the supported software and accessories for the instrument 
modules.

• Chapter 2, “Preparing to Use the DT8824 or DT8824-HV,” describes how to unpack the 
DT8824 and DT8824-HV, check the system requirements, install the software, and view 
the DT8824 documentation online.

• Chapter 3, “Setting Up and Installing the DT8824 or DT8824-HV,” describes how to install 
the DT8824 and DT8824-HV instrument modules, how to apply power, and connect the 
instrument module to the network. 

• Chapter 4, “Wiring Signals,” describes how to wire signals to the DT8824 and DT8824-HV 
instrument modules. 

• Chapter 5, “Verifying the Operation of the DT8824 or DT8824-HV,” describes how to 
verify the operation of a DT8824 and DT8824-HV instrument modules. 

• Chapter 6, “Principles of Operation,” describes all of the features of the DT8824 and 
DT8824-HV instrument modules in detail.
9
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• Chapter 7, “Troubleshooting,” provides information that you can use to resolve problems 
with the DT8824 and DT8824-HV instrument modules and device driver, should they 
occur.

• Appendix A, “Specifications,” lists the specifications of the DT8824 and DT8824-HV.

• Appendix B, “Connector Pin Assignments,” lists the pins for each of the connectors on the 
DT8824 and DT8824-HV.

• Appendix C, “Configuring Network Settings on Your PC,” describes how to configure the 
network settings of your PC to use Auto-IP or a static IP address.

• Appendix D, “Using the Bonjour Discovery Utility,” describes how to use the Bonjour 
utility to discover a DT8824 or DT8824-HV instrument module on the network.

• Appendix E, “About ISO-Channel Technology,” describes the benefits of the 
ISO-ChannelTM design.

• An index completes this manual.

Conventions Used in this Manual

The following conventions are used in this manual:

• Notes provide useful information or information that requires special emphasis, cautions 
provide information to help you avoid losing data or damaging your equipment, and 
warnings provide information to help you avoid catastrophic damage to yourself or your 
equipment.

• Items that you select or type are shown in bold.

Related Information

Refer to the following documents for more information on using the DT8824 instrument 
module:

• DT8824 IVI-COM Driver online help. For programmers who are developing their own 
application programs, this document describes how to use the IVI-COM driver to access 
the capabilities of the DT8824 and DT8824-HV instrument modules. The DT8824 
IVI-COM driver works with any development environment that supports COM 
programming, including MATLAB® from The MathWorksTM, Microsoft® Visual C#®.NET 
or Visual Basic®.NET, Agilent® VEE Pro, National Instruments™ LabVIEW™ or 
LabWindows™, and so on.

• QuickDAQ User’s Manual (UM-24774). This manual describes how to create a QuickDAQ 
application to acquire and analyze data from a data acquisition device.

• SCPI Programmer’s Manual for the DT8824 and DT8824-HV (UM-24017). For programmers 
who want to use the SCPI interface to program DT8824 or DT8824-HV instrument 
module, this document describes the supported SCPI commands and example programs 
for the DT8824 and DT8824-HV instrument modules.

• IVI foundation (www.ivifoundation.org)

• LXI Consortium (www.lxistandard.org)
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Where To Get Help

Should you run into problems installing or using a DT8824 or DT8824-HV instrument 
module, the Data Translation Technical Support Department is available to provide technical 
assistance. Refer to page 89 for more information. If you are outside the United States or 
Canada, call your local distributor, whose number is listed on our web site 
(www.mccdaq.com). 
11
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DT8824 and DT8824-HV Hardware Features
The DT8824 and DT8824-HV instrument modules, are high-performance, multifunction data 
acquisition devices for the Ethernet (LXI) bus. They are class C devices and comply with LXI 
version 1.3. Figure 1 shows the DT8824 instrument module.

Figure 1: DT8824 Instrument Module

The key hardware features of the DT8824 and DT8824-HV instrument modules are as follows: 

• LXI Class C compliance with built-in Ethernet connectivity 

• ISO-Channel™ protection eliminates noise and ground loops. 

The DT8824 provides ±500 V galvanic isolation channel-to-channel on all analog input 
signals and to the host computer to protect signal integrity. 

The DT8824-HV provides ±1000 V galvanic isolation channel-to-channel on all analog 
input signals and to the host computer to protect signal integrity. (See Appendix E for 
more information on ISO-Channel.)

• Four simultaneous, 24-bit analog input channels

• Sampling frequency of up to 4800 Hz

• The DT8824 supports input gains of 1, 8, 16, and 32 with input ranges of ±10 V to support 
the following effective ranges: ±10 V, ±1.25 V, ±0.625 V, or ±0.3125 V

• The DT8824-HV supports input gains of 1, 8, 16, and 32 with input ranges of ±600 V to 
support the following effective ranges: ±600 V, ±75 V, ±37.5 V, or ±18.75 V

• Continuously paced analog input operations 

• Software-programmable trigger type (software, external digital trigger, Trigger Bus, or 
LAN trigger) to start analog input operations. 

• Software calibration of the analog input subsystem 
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• 4 opto-isolated digital output lines; the outputs are solid-state relays that operate from 
±30 V at currents up to 400 mA (peak) AC or DC

• Digital outputs are galvanically isolated to ±250 V when using all digital output lines 
15
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Supported Software
The following software is available for use with the DT8824 and DT8824-HV instrument 
modules:

• Eureka Discovery Utility – This utility helps you locate or "discover" all LXI (Ethernet) 
instruments that are connected to your system and provides the following information 
about your instrument: the IP address, manufacturer, model number, serial number, and 
version of the firmware that is running on your instrument. In addition, you can use this 
utility to configure Windows firewall settings and update the firmware for your Data 
Translation LXI instrument module.

• DT8824 Web Interface – This built-in interface, described in Chapter 5, allows you to 
calibrate a DT8824 or DT8824-HV instrument module, configure your instrument module, 
measure input signals, and save results to disk using Internet Explorer and no additional 
software. 

• QuickDAQ Base Version – The base version of QuickDAQ is free-of-charge and allows 
you to acquire and analyze data from all Data Translation USB and Ethernet devices, 
except the DT9841 Series, DT9817, DT9835, and DT9853/54. Using the base version of 
QuickDAQ, you can perform the following functions:

− Discover and select your devices.

− Configure all input channel settings for the attached sensors.

− Load/save multiple hardware configurations.

− Generate output stimuli (fixed waveforms, swept sine waves, or noise signals).

− On each supported data acquisition device, acquire data from all channels supported 
in the input channel list.

− Choose to acquire data continuously or for a specified duration.

− Choose software or triggered acquisition.

− Log acquired data to disk in an .hpf file.

− Display acquired data during acquisition in either a digital display using the Channel 
Display window or as a waveform in the Channel Plot window.

− Choose linear or logarithmic scaling for the horizontal and vertical axes.

− View statistics about the acquired data, including the minimum, maximum, and mean 
values and the standard deviation in the Statistics window.

− Export time data to a .csv or .txt file; you can open the recorded data in Microsoft 
Excel® for further analysis.

− Read a previously recorded .hpf data file. 

− Customize many aspects of the acquisition, display, and recording functions to suit 
your needs, including the acquisition duration, sampling frequency, trigger settings, 
filter type, and temperature units to use.
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• QuickDAQ FFT Analysis Option – When enabled with a purchased license key, the 
QuickDAQ FFT Analysis option includes all the features of the QuickDAQ Base version 
plus basic FFT analysis features, including the following:

− The ability to switch between the Data Logger time-based interface and the FFT 
Analyzer block/average-based interface.

− Supports software, freerun, or triggered acquisition with accept and reject controls for 
impact testing applications.

− Allows you to perform single-channel FFT (Fast Fourier Transform) operations, 
including AutoSpectrum, Spectrum, and Power Spectral Density, on the acquired 
analog input data. You can configure a number of parameters for the FFT, including 
the FFT size, windowing type, averaging type, integration type, and so on.

− Allows you to display frequency-domain data as amplitude or phase.

− Supports dB or linear scaling with RMS (root mean squared), peak, and peak-to-peak 
scaling options

− Supports linear or exponential averaging with RMS, vector, and peak hold averaging 
options.

− Supports windowed time channels.

− Supports the following response window types: Hanning, Hamming, Bartlett, 
Blackman, Blackman Harris, and Flat top.

− Supports the ability to lock the waveform output to the analysis frame time.

− Allows you to configure and view dynamic performance statistics, including the input 
below full-scale (IBF), total harmonic distortion (THD), spurious free dynamic range 
(SFDR), signal-to-noise and distortion ratio (SINAD), signal-to-noise ratio (SNR), and 
the effective number of bits (ENOB), for selected time-domain channels in the Statistics 
window.

• QuickDAQ Advanced FFT Analysis Option – When enabled with a purchased software 
license, the QuickDAQ Advanced FFT Analysis option includes all the features of the 
QuickDAQ Base version with the FFT Analysis option plus advanced FFT features, 
including the following:

− Allows you to designate a channel as a Reference or Response channel.

− Allows you to perform two-channel FFT analysis functions, including Frequency 
Response Functions (Inertance, Mobility, Compliance, Apparent Mass, Impedance, 
Dynamic Stiffness, or custom FRF) with H1, H2, or H3 estimator types, 
Cross-Spectrum, Cross Power Spectral Density, Coherence, and Coherent Output 
Power.

− Supports the Exponential response window type.

− Supports the following reference window types: Hanning, Hamming, Bartlett, 
Blackman, Blackman Harris, FlatTop, Exponential, Force, and Cosine Taper windows.

− Supports real, imaginary, and Nyquist display functions.

− Allows you to save data in the .uff file format.
17
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• Dtx8824 IVI-COM driver – This driver provides access to the functions of the DT8824 and
DT8824-HV instrument modules through a COM server. The IVI-COM driver works in
any development environment that supports COM programming, including MATLAB,
Visual Basic.NET, Visual C#.NET, Agilent VEE Pro, LabVIEW, LabWindows, and others.

• SCPI commands – Use SCPI commands to program DT8824 and DT8824-HV instrument
modules. Refer to the SCPI Programmer’s Manual for the DT8824 and DT8824-HV
(UM-24017) for information on the supported SCPI commands and example programs.

Refer to the Data Translation web site (www.mccdaq.com) for information about 
selecting the right software package for your needs.
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Accessories
Table 1 lists the optional accessories are available for the DT8824 and DT8824-HV.

Table 1: Optional Accessories Available for the DT8824 and DT8824-HV

Accessory Description

STP8837 Assembly Screw terminal panel assembly for attaching 
digital output and trigger signals to the 
DT8824 and DT8824-HV instrument 
modules. In addition to the screw terminal 
panel, this assembly also includes the EP378 
cable for connecting the screw terminal panel 
to the instrument module and two DIN rail 
adaptors for attaching the STP8837 screw 
terminal panel to a DIN rail.

EP377 Trigger Bus cable (25-pin, .5 M) for attaching 
two DT8824 and/or DT8824-HV instrument 
modules together.

EP380 Single rack-mount kit for mounting one 
DT8824 or DT8824-HV instrument module 
into a 1U rack.

EP379 Dual Rack-mount kit for mounting two 
DT8824 and/or DT8824-HV instrument 
modules side by side into a 1U rack.
19
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Getting Started Procedure
The flow diagram shown in Figure 2 illustrates the steps needed to get started using the 
DT8824 and DT8824-HV instrument modules. This diagram is repeated in each Getting 
Started chapter; the shaded area in the diagram shows you where you are in the getting 
started procedure. 

Figure 2: Getting Started Flow Diagram
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Unpacking
Open the shipping box and verify that the following items are present:

• DT8824 or DT8824-HV instrument module

• EP372 Ethernet cable

• EP361 +5V power supply and cable

• Trigger Bus terminators

• DT8824 CD-ROM

• A bag of pluggable screw terminable blocks and a screwdriver

If an item is missing or damaged, contact Data Translation. If you are in the United States, call 
the Customer Service Department at (508) 946-5100. An application engineer will guide you 
through the appropriate steps for replacing missing or damaged items. If you are located 
outside the United States, call your local distributor, listed on Data Translation’s web site 
(www.mccdaq.com).
25
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Checking the System Requirements 
For reliable operation, the computer that accesses your DT8824 or DT8824-HV instrument 
module requires the following configuration: 

• Processor: Pentium 4/M or equivalent

• RAM: 1 GB

• Screen Resolution: 1024 x 768 pixels

• Disk Space: 4 GB

• Ethernet port

• CD-ROM drive

• Administrator privileges for software installation

• For access to the instrument web interface:

− Java Version 6, Update 5 or greater

− Internet Explorer web browser, preferably version 8.0

Refer to page 49 for more information on installing Java and configuring your browser 
settings

• Acrobat Reader 5.0 or later for viewing documentation
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Installing the Software
This section describes how to install the software you need to use a DT8824 or DT8824-HV 
instrument module.

Prerequisite Software

No prerequisite software is required if you are using a single client to access a DT8824 or 
DT8824-HV instrument module on the LXI bus, or if you are managing how multiple clients 
concurrently access a DT8824 or DT8824-HV instrument module on the LXI bus. (In these 
case, your application can use sockets to communicate with the instrument module.)

If, however, you want multiple clients to access the DT8824 or DT8824-HV instrument module 
on the LXI bus, and you want to "lock" access to the instrument module so that one client 
cannot change the configuration of an instrument module that another client is accessing, you 
need to install VISA; we recommend either Agilent VISA or NI-VISA from National 
Instruments. You can then use the VISA methods viLock/viUnlock to prevent other clients 
from accessing the instrument module.

To install Agilent VISA, do the following:

1. Go to www.agilent.com, enter IO Libraries Suite in the search field, and select Agilent 
IO Libraries Suite 15.0 from the search results.

2. Follow the instructions on Agilent’s web site to download and install the Agilent IO 
Libraries, which include VISA support, VISA COM support, and the Agilent Connection 
Expert tool.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided with 
the instrument module to locate your DT8824 or DT8824-HV LXI instrument module on the 
network (see page 54 for more information). 

Installing the DT8824 Software

To install the DT8824 software (including the DT8824 IVI-COM driver, Eureka Discovery 
Utility, and DT8824 SCPI Support) and related documentation, perform the following steps:

1. Insert the DT8824 CD into your CD-ROM or DVD drive.
The installation program should automatically start, and the DT8824 installation program should 
appear.

2. If the installation program does not automatically start, double-click Setup.exe from the 
CD.
The DT8824 installation program appears.

3. Click Install from Web (recommended) to get the latest version of the software or Install 
from CD to install the software from the CD.

4. If you are installing from the web, click DT8824 Software to install the DT8824 software.

5. If you are installing from the DT8824 CD, click Install Features. When you are finished 
with the DT8824 CD, click Quit Installer.
27
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Viewing the Documentation

Note: To view the documentation, you must have Adobe Reader 5.0 or greater installed on 
your system. 

You can access the documentation for your DT8824 Series instrument module from the 
Windows Start menu as follows:

• For documentation about the DT8824, click Programs -> Data Translation, Inc -> 
Instruments -> DT8824 -> DT8824 User’s Manual.

• For documentation on the DT8824 IVI-COM driver, click Programs -> Data Translation, 
Inc -> IVI -> DT8824 -> Documentation.

• For documentation on the Eureka Discovery Utility, click Programs -> Data Translation, 
Inc -> Instrument Support -> Eureka LXI Instrument Discovery Help.

• For documentation about SCPI support for the DT8824, click Programs -> Data 
Translation, Inc -> Instruments -> DT8824 -> SCPI Support -> SCPI Programmer’s 
Manual for the DT8824.

The following may be helpful when using Adobe Reader: 

• To navigate to a specific section of the document, click a heading from the table of contents 
on the left side of the document.

• Within the document, click the text shown in blue to jump to the appropriate reference 
(the pointer changes from a hand to an index finger).

• To go back to the page from which the jump was made, click the right mouse button and 
Go Back, or from the main menu, click Document, and then Go Back.

• To increase or decrease the size of the displayed document, from the main menu, click 
View, and then Zoom.

• By default, Adobe Reader smooths text and monochrome images, sometimes resulting in 
blurry images. If you wish, you can turn smoothing off by clicking File, and then 
Preferences/General, and unchecking Smooth Text and Images. 
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Connecting the DT8824 or DT8824-HV to the LAN
This section describes how to connect the DT8824 or DT8824-HV instrument module to the 
LAN (Local Area Network). Two connection schemes are shown:

• Site LAN connections, described on this page

• Private LAN connections, described on page 41

Note: It is recommended that you consult with your network administrator to ensure that 
all network security, performance, and reliability issues are considered when connecting 
DT8824 instrument modules to the LAN.

Connecting to a Site LAN

A site LAN is useful in applications that require access by many users or access by users at 
distributed sites. In this connection scheme, a DHCP (Dynamic Host Configuration Protocol) 
server is used to assign an IP address to the DT8824 or DT8824-HV instrument module.

Figure 2 shows a typical site LAN connections using a dedicated Ethernet hub, switch, or 
router. Figure 3 shows typical site LAN connections without using a dedicated Ethernet hub, 
switch, or router.

Note: Use standard LAN cables for network connections. The DT8824 and DT8824-HV ship 
with a standard LAN cable (EP372) for connecting to the LAN (RJ45) connector on the rear 
panel of the instrument module.

Figure 3: Typical Site LAN Connections using a Hub, Switch, or Router
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31



Chapter 3

32
Figure 4: Typical Site LAN Connections Without Using a Hub, Switch, or Router

Connecting to a Private LAN

A private LAN (or subnet) generally involves the direct connection of the instrument modules 
to the computer, and may include Ethernet hubs or switches. Access to the instrument 
modules is limited to users that are directly connected to the private LAN; therefore, security, 
performance, and reliably are generally better on a private LAN than on a site LAN.

In this connection scheme, the DHCP (Dynamic Host Configuration Protocol) server is 
typically not available; therefore, Auto-IP is used to assign an IP address to the DT8824 or 
DT8824-HV instrument module.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must 
temporarily reconfigure your PC to use Auto-IP, as described in Appendix C on page 114.

Connecting Using a Hub or Switch

Figure 4 shows a typical connection scheme when connecting DT8824 or DT8824-HV 
instrument modules to a private LAN using a dedicated Ethernet hub or switch. 

Note: Use standard LAN cables for network connections. The DT8824 and DT8824-HV ship 
with a standard LAN cable (EP372) for connecting to the LAN (RJ45) connector on the rear 
panel of the instrument module.
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Figure 5: Typical Private LAN Connections using a Hub or Switch

Connecting Directly to a Computer

Optionally, you can connect the DT8824 or DT8824-HV directly to your computer, creating an 
ad hoc network, as shown in Figure 5. Be aware that the time and date settings of the 
instrument module will not be updated using this connection method. Therefore, this 
connection scheme is generally recommended for quick set up and verification only.

Note: DT8824 and DT8824-HV instrument modules do not support the Auto-MDIX 
function; therefore, use a crossover cable rather than a standard LAN cable to connect your 
DT8824 instrument module unless your computer has enabled the Auto-MDIX function. 

Figure 6: Typical Private LAN Connections when Connecting Directly to a Computer
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Applying Power
The DT8824 and DT8824-HV instrument modules are shipped with an EP361 +5V power 
supply and cable. To apply power to the instrument module, do the following: 

1. Connect the +5 V power supply to the power connector on the rear panel of the DT8824 or 
DT8824-HV. Refer to Figure 6.

Figure 7: Attaching a +5 V Power Supply to the DT8824 or DT8824-HV

2. Plug the power supply into a wall outlet. 

3. Press the Power switch on the rear panel of the instrument module, shown in Figure 6, to 
turn on the DT8824 or DT8824-HV instrument module.
The Power LED on the front panel lights to indicate that power is on.

Figure 7 shows the front panel of the DT8824 and DT8824-HV, including the locations of the 
LEDs.

Connect the +5 V EP361 Power Supply to 
the 5V In Power Connector 

Power Switch
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Figure 8: Front Panel of the DT8824 and DT8824-HV

Table 2 describes the LEDs on the front panel. Use these LEDs along with the LEDs on the rear 
panel, described on page 38, to determine the status of operation on the DT8824 and 
DT8824-HV.

Table 2: The LEDs on the Front Panel of the DT8824 and DT8824-HV

LEDs Color Description

LAN LED Solid Green Instrument module has valid IP address.

Blinking Green Instrument module identified using the Web 
interface; see page 54 for more information.

Red If the Ethernet link is operational, the 
instrument module does not have a valid IP 
address. 

Otherwise, the Ethernet link is not 
operational.

Power LED Off Instrument module not powered on.

Solid Green Instrument module powered on.

Trig In Off Instrument module is idle.

Solid Amber Analog input subsystem is armed.

Solid Green Analog input subsystem is triggered.

Power LED Trig In LED

LAN LED
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Getting an IP Address and Host Name
Once your DT8824 or DT8824-HV is connected to the LAN and powered on, the instrument 
module automatically requests an Ethernet address from a DHCP (Dynamic Host 
Configuration Protocol) server, if available, and a host name from a DNS (Dynamic Domain 
Name Service) server, if available. 

If these services are not available on the LAN, the DT8824 or DT8824-HV uses Auto-IP to set 
up its TCP/IP configuration. In this case, the IP address will be in the range of 169.254.0.0 to 
169.254.255.255 with a subnet mask of 255.255.255.0.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must 
temporarily reconfigure your PC to use Auto-IP, then configure your DT8824 instrument 
module to use a static IP address, as described in Appendix C on page 117.

You can use the DT8824 web interface, described in Chapter 5 starting on page 47, to see the IP 
address and host name that is assigned to your DT8824 or DT8824-HV instrument module. 

Note: When programming a DT8824 or DT8824-HV, you access the instrument module 
through its address string, which consists of an IP address or host name, such as 
TCPIP0::192.43.218.69::inst0::INSTR or TCPIP0::192.43.218.69::SOCKET. If a host name was 
returned by the DNS server, you can also address the instrument module using its host name, 
such as TCPIP0::arrakis.datx.com::inst0::INSTR.

For IVI-COM programmers, you can also assign a VISA alias to the instrument module. For 
example, rather than addressing the DT8824 as TCPIP0::192.43.218.69::inst0::INSTR, you can 
use the VISA alias DT8824_1 instead. See your VISA documentation for more information on 
VISA resource strings and creating VISA aliases.
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Determining Ethernet Activity
You can use the ENet Link and ENet Activity LEDs on the rear panel of the DT8824 or 
DT8824-HV, shown in Figure 9, with the LAN LED on the front panel of the DT8824 or 
DT8824-HV, shown in Figure 8, to determine the Ethernet activity of your instrument module. 

Figure 9: Rear Panel of the DT8824 and DT8824-HV

Table 1 describes the LEDs on the rear panel.

Table 3: LEDs on the Rear Panel of the DT8824 and DT8824-HV

LEDs Color Description

ENet Link LED
(on rear panel)

Yellow Ethernet link operational.

Off Ethernet link not operational.

ENet Activity LED
(on rear panel)

Green Network traffic detected.

Off No network traffic detected.

ENet Activity
LED

ENet Link
LED
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Resetting the Instrument Module
If needed, you can restore the default configuration of the DT8824 or DT8824-HV by pressing 
the Reset pin on the rear panel of the instrument module, shown in Figure 10, until the LAN 
LED on the front panel turns off (which takes approximately 5 seconds), and then releasing 
the Reset pin.

Figure 10: Reset Pin

The instrument module reboots automatically using the factory-default LAN configuration 
(DHCP and auto-IP enabled); this process typically takes up to 40 seconds to complete. This 
forces the instrument module to re-acquire an IP address from the DHCP server, or if that fails, 
to use Auto-IP to get an IP address.

Note: The default configuration overwrites any changes that you have made to the LAN 
configuration (IP address and password) using the instrument module’s web interface.

The calibration parameters are not affected by the reset.

Reset Pin
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(see Chapter 3 starting on page 29)

Wire Signals
(see Chapter 4 starting on page 39)

Verify the Operation of the DT8824 or DT8824-HV
(see Chapter 5 starting on page 47)

Prepare to Use the DT8824 or DT8824-HV
(see Chapter 2 starting on page 23
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Preparing to Wire Signals
The DT8824 and DT8824-HV provide four analog input channels with screw terminal 
connectors for connecting analog input signals, shown in Figure 11, and a 37-pin digital I/O 
connector for attaching 4 opto-isolated digital output signals, shown in Figure 12.

Figure 11: Analog Input Connectors on the DT8824 and DT8824-HV (Front Panel)

Figure 12: Digital I/O Connector on the DT8824 and DT8824-HV (Rear Panel)

Analog Input Channels

Digital I/O Connector
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Keep the following recommendations in mind when wiring signals to the DT8824 and 
DT8824-HV instrument modules:

• Follow standard ESD procedures when wiring signals to the instrument module.

• Use individually shielded twisted-pair wire (size 14 to 26 AWG) when using the DT8824 
and DT8824-HV instrument modules in highly noisy electrical environments.

• Separate power and signal lines by using physically different wiring paths or conduits.

• To avoid noise, do not locate the DT8824 and DT8824-HV instrument modules and 
cabling next to sources that produce high electromagnetic fields, such as large electric 
motors, power lines, solenoids, and electric arcs, unless the signals are enclosed in a 
mumetal shield.

• Prevent electrostatic discharge to the I/O while the DT8824 and DT8824-HV instrument 
modules are operational.

• Connect all unused analog input channels to analog ground.
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Connecting Analog Input Signals
You can connect analog input signals to the DT8824 or DT8824-HV instrument module in the 
differential configuration only. Figure 13 shows the numbering of the screw terminal blocks 
for analog input connections.

Figure 13: Screw Terminal Block Numbering for Analog Input Connections

Note: To make wiring easier, use the supplied screwdriver to attach your signals to the 
screw terminal block. When you are finished, plug the screw terminal block into the screw 
terminal header that corresponds to the channel to which you are wiring.

Figure 14 shows how to connect voltage inputs to the DT8824 or DT8824-HV.

 

Figure 14: Connecting Voltage Inputs

Note: For best accuracy when connecting voltage inputs, use twisted-pair wires with a 
dead-ended shield connected to pin 4 of the screw terminal block.

1
+

3
–

2
No 

Connect

4
GND

Vin +Vin –

Analog Input Channel

– +

124 3

Shield

*Pin 2 is no connect
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Connecting Digital Output Signals
he digital output lines on the DT8824 and DT8824-HV act as solid-state relays. The 

customer-supplied signal can be ±30 V at up to 400 mA (peak) AC or DC. You can use the 
digital output lines of the module to control solid-state or mechanical relays or high-current 
electric motors.

To make digital output connections easier, you can use the optional STP8837 screw terminal 
panel and EP378 cable with your DT8824 or DT8824-HV instrument module. Connect the 
STP8837 to the digital output connector of the DT8824 or DT8824-HV as shown in Figure 15:

Figure 15: Connecting the DT8824 or DT8824-HV to the STP8837

EP378 Cable

STP8837
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Figure 16 shows the layout of the STP8837 screw terminal panel and lists the assignments of 
each screw terminal.

Figure 16: STP8837 Screw Terminal Panel

Figure 17 shows how to connect digital output signals to line 0 of a DT8824 or DT8824-HV 
instrument module to control a motor relay.

Figure 17: Switching up to 30 V at 400 mA

J1

1
9
2

10
3

11

TB1 TB2

Trigger Input High 15 Digital Output 3B

7 Digital Output 3A

14 Digital Output 2B

6 Digital Output 2A

13 Digital Output 1B

5 Digital Output 1A

12 Digital Output 0B

4 Digital Output 0A

Trigger Input Low

Digital Out 0B

Digital Out 0Apin 4

120 V AC
or 240 V AC

Relay

Motor

10 A 
Fuse

NeutralHot

30V DC @ 400 mA

+ *–
pin 12

DT8824 or DT8824-HV
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You can configure, measure, and control the DT8824 instrument module either locally or 
remotely using the DT8824 web interface, described in this chapter. This utility also allows 
you to calibrate the DT8824 instrument module.

Set Up and Install the DT8824 or DT8824-HV
(see Chapter 3 starting on page 29)

Wire Signals
(see Chapter 4 starting on page 39)

Verify the Operation of the DT8824 or DT8824-HV
(see Chapter 5 starting on page 47)

Prepare to Use the DT8824 or DT8824-HV
(see Chapter 2 starting on page 23
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Before Using the Web Interface
This section describes system requirements and browser settings for proper operation of the 
instrument module’s web interface.

Note: At any instant, up to 8 clients can access the DT8824 or DT8824-HV instrument 
module concurrently using the web interface.

Up to 12 additional clients can access the DT8824 or DT8824-HV instrument module 
concurrently using SCPI commands over VISA or sockets. Of these, 4 can be VXI-11 clients, 
which use the ::SOCKETS or VISA::INSTR resource to access the instrument module. 

At this time, the web and SCPI interfaces cannot be "locked;" therefore, one client can change 
the configuration of the instrument module that another client is accessing. However, you 
can optionally lock the VXI-11 interface using the VISA APIs viLock/viUnlock; this prevents 
other VXI-11 clients (including VXI-11 discovery) from accessing the instrument module. 
Refer to the SCPI documentation for your instrument module for more information on 
supported SCPI commands.

Java Requirements

Before using the instrument web interface, ensure that your computer has Version 6, Update 5 
or greater of Java installed; this version of Java installs version 1.6 of the Java plug-in. You can 
verify Java versions and settings by accessing the Java Control Panel, select Windows Start -> 
Control Panel and open the Java dialog. To download or upgrade Java, go to www.java.com.

Browser Settings

To access the web pages for your instrument, you can use Internet Explorer or Firefox. 

If you are using Internet Explorer, ensure that your browser is configured as follows:

• JavaScript (Active Scripting) must be enabled

• Security level of the DT8824 instrument module IP address must be Medium-high or 
lower

• Pop-up blockers must be disabled

The following sections describe how to configure these settings.
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JavaScript

To enable JavaScript (also referred to as Active Scripting), perform the following steps:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Select Internet, and then click Custom Level.

4. Scroll down to the Scripting section.

5. Under Active Scripting, select Enable, and then click OK.

Security Levels

By default, the IP address of the DT8824 or DT8824-HV instrument module is added to the 
Internet zone. If you'd rather leave the settings of the Internet zone at a level higher than 
Medium-high, then you can add the IP address of the instrument module to either the Local 
intranet or Trusted sites zone and configure the security level of that zone to Medium-high or 
lower.

The following section describe how to configure each zone.

Internet Zone

To configure the security level of the DT8824 or DT8824-HV instrument module’s IP address 
in the Internet zone, perform the following steps:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.
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3. Select Internet and move the slide bar to select a security level of Medium-high or lower.

4. Click OK.

Local Intranet Zone

To add the IP address of the DT8824 or DT8824-HV to the Local intranet zone and configure 
its security level, do the following:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Click Local intranet, and click Sites.

4. Select which web sites to add to the zone, and then click Advanced.

5. Enter the IP address of the DT8824 or DT8824-HV to the zone (note that the address must 
be prefaced by (http://), and click Add.
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6. Click Close, and then click OK.

7. Move the slide bar to select a security level of Medium-high or lower.

8. Click OK.

Trusted Sites Zone

To add the IP address of the DT8824 or DT8824-HV to the Trusted sites zone and configure its 
security level, do the following:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Click Trusted sites, and click Sites.

4. Enter the IP address of the DT8824 or DT8824-HV to the zone (note that the address must 
be prefaced by (https://), and click Add.
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5. Click Close.

6. Move the slider bar to select a security level of Medium-high or lower.

7. Click OK.

Pop-up Blockers

To disable pop-up blockers, perform the following steps:

1. From the Internet Explorer browser, select Tools ->Pop-up Blocker.

2. Select Turn Off Pop-up Blocker.
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Locating Your Instrument Module on the LAN
To access the web interface of your instrument module, you must determine its IP address on 
your TCP/IP network. 

Note: Discovery will work only for devices on the same subnet.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided with 
the DT8824 software to locate your DT8824 or DT8824-HV instrument module quickly. 
Alternatively, you can use other LXI discovery tools, such as Bonjour from Apple (described in 
Appendix D starting on page 119) or Agilent Connection Expert, if you have them installed on 
your computer. Or you can check your router’s address assignments or locate the instrument 
module’s MAC (Ethernet hardware) address in your DHCP server log.

Running the Eureka Discovery Utility

To use the Eureka Discovery Utility, from the Windows Start menu, click Programs -> Data 
Translation, Inc -> Instrument Support -> Eureka LXI Instrument Discovery.
A screen similar to the one shown in Figure 18 appears.

Figure 18: Eureka LXI Discovery Utility

If you are having trouble seeing your instrument module in this list, check your Windows 
firewall settings using the information in the next section; otherwise, skip this section and 
continue with “Launching the Web Interface” on page 56.
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Configuring Windows Firewall Settings

If you are having trouble seeing your instrument module using the Eureka Discovery Utility, 
check your Windows firewall settings by doing the following:

1. Right click in the tile bar of the Eureka Discovery Utility.
The following menu options appear:

2. Click the Firewall Configuration... option.

3. In Windows XP:

a. From the General tab, select the On (recommended) setting for proper operation of 
the Eureka Discovery Utility.

b. Click the Exceptions tab, and ensure that Eureka LXI Instrument Discovery is 
included in the list of exceptions.

c. If Eureka LXI Instrument Discovery is not included in the exception list, add the 
utility to the list of exceptions by clicking Add Program..., browse to C:\Program 
Files\Data Translation\Instrument Support\Eureka.exe, and then click OK to add 
the utility to the list of exceptions.

d. Click OK to exit from the Windows Firewall Configuration menu.

4. In Windows 7: 

a. Click Turn Windows Firewall on or off.

b. For each network, click Turn on Windows Firewall, and then click OK.

c. Click Allow a program or feature through Windows Firewall, and ensure that 
Eureka LXI Discovery is included in the list of allowed programs.

d. If Eureka LXI Discovery is not included in the list, add the utility to the list of allowed 
programs by clicking Allow another program..., browse to C:\Program Files\Data 
Translation\Instrument Support\Eureka, click Open, and the click Add to add the 
utility to the list of allowed programs.

e. Click OK, and then click OK again to exit from the Windows Firewall Configuration 
menu.
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Launching the Web Interface

From the Eureka utility, double-click the appropriate IP address to open the web pages for 
your instrument module using your default web browser. 

Alternatively, you can enter the IP address of your instrument module directly in your 
Internet Explorer address bar to see the instrument module’s web interface.

The main web page shows information about your DT8824 or DT8824-HV instrument module 
on the network:

If you have multiple DT8824 or DT8824-HV instrument modules, you can click the Turn on 
button to light the LAN LED on the instrument module, described on page 35, to indicate 
which device you are using.

If you want to make changes to this page, click the Modify button at the bottom of the page or 
click Configuration -> LAN on the left side of the page to navigate to the LAN Configuration 
page, described on page 57.
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Configuring the DT8824 or DT8824-HV Instrument 
Module

Web pages are provided for configuring the following aspects of your DT8824 or DT8824-HV 
instrument module: 

• Local Area Network (LAN) settings

• Analog input channels

• Clock frequency

• Trigger settings

• A/D Buffer mode

LAN Configuration

Use the Configuration -> LAN web page to configure the Local Area Network (LAN) settings 
of the DT8824 or DT8824-HV:
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When you first access your DT8824 or DT8824-HV instrument module, the LAN settings that 
the instrument module obtained through DHCP or Auto-IP should be sufficient. If you need 
to make changes later, click the Modify button at the top of the page 

Note: If you want to assign a static IP address, ensure that you uncheck the checkbox called 
Automatic private IP address enabled.

When you click Modify, you must supply a user name and password for the instrument 
module. The user name is admin; it cannot be changed. The default password is admin.

You can configure the following settings on the LAN web page:

• Hostname – The mDNS (or Bonjour) name. This is the name in the link-local domain. On 
power up, each device is registered with the DNS name "hostname.local" where hostname 
is the string entered here. 

• Description – Enter additional textual information to identify the instrument on your 
network. For example, you could change this field to "Lab6 furnace." 

• DHCP – Select this radio button to obtain an IP address automatically from a DHCP 
(dynamic host configuration protocol) server on your local area network (recommended). 
When it first starts up, the instrument is configured for DHCP, by default. 

• Automatic private IP address enabled – Check this box to turn on Auto-IP. If DHCP is 
unavailable and Auto-IP is on, the instrument automatically determines a valid IP 
address, subnet mask, and default gateway on the local physical link. You can use Auto-IP 
in an "ad hoc" network configuration, such as when the device is connected directly to 
your computer through a crossover cable or hub. 

• Static – Select this radio button to configure the instrument's IP address parameters 
manually. 

• Static IP address – If Static is selected, enter an available LAN IP address for your 
instrument module. 

• Mask – If Static is selected, enter an IP address mask to identify the subnet where the 
instrument resides. 

• Gateway – If Static is selected, enter the IP address of the LAN device that serves as a 
gateway to other subnets and the wide area network. 

• Primary/Secondary SNTP Server – Enter the IP addresses of SNTP (simple network time 
protocol) servers that synchronize the instrument module's internal clock to the rest of 
your LAN. 

• Time Zone – Configure the time zone as an integral number of one-half hours either 
ahead or behind Greenwich Mean Time (GMT). For example, for US Eastern Standard 
Time (EST), enter –5 hours, as US EST is –5 hours behind GMT. 

• Event Domain– Enter a value between 0 and 255. This value is used with LAN events in 
device-to-device communication. All devices that have identical event domains can send 
LAN events to each other or receive LAN events from each other. 
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• Password – Use this field to change the instrument's password for the LAN web page. 
Note that the new password goes into effect after the device reboots. If you are prompted 
for a password before the device reboots, you must enter your original password. 

Notes: Contact your system administrator to determine the correct LAN settings for your 
device on the network.

If needed, you can restore the default configuration of your DT8824 or DT8824-HV 
instrument module by pressing the Reset pin on the rear panel of the instrument module. For 
more information, refer to page 38.

Analog Input Configuration and Calibration

Use the Configuration -> Analog input web page to enable the analog input channels that 
you want to measure, specify the gain for each channel, and if desired, calibrate the analog 
input channels:

Configuring Analog Input Channels

To change your channel configuration, do the following: 

1. Under Enable Channel, check the boxes next to the channels whose data you want to 
acquire.

2. Under Gain/Range, select one of the following gain values for each analog input channel:
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3. Click Save changes to apply your changes. If you do not save before leaving this page, 
your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.

Calibrating Analog Input Channels

DT8824 and DT8824-HV instrument modules are calibrated at the factory and should not 
require calibration for initial use. We recommend that you check and, if necessary, readjust the 
calibration of the analog input circuitry on the DT8824 and DT8824-HV instrument modules 
every six months using the DT8824 web application.

To calibrate the 24-bit A/D offset and A/D gain circuits on your instrument module, the 
following equipment is recommended:

• A precision voltage standard. 

• A 6 1/2 digit precision voltmeter that is connected to the input to help verify and adjust 
the voltage source at the input precisely.

• Twisted pair wires, since BNC cables can have thermal EMF greater than the accuracy of 
your device.

• Dead short for calibrating the offset at 0 V.

Note: Ensure that you let the DT8824 or DT8824-HV instrument module warm up for a 
minimum of 1 hour before calibrating it.

To calibrate the analog input channels, do the following: 

1. Select the Calibration link at the bottom of the Analog input web page.
A Windows Security dialog box appears.

2. You must supply a user name and password for the instrument module. The user name is 
admin; it cannot be changed. The default password is admin. If you changed the default 
password by configuring the LAN settings (described on page 59), enter the new 
password here.
For the DT8824, a page similar to Figure 19 appears. For the DT8824-HV, a page similar to Figure 
20 appears.

Gain Range

x1 ±10 V

x8 ±1.25 V

x16 ±0.625 V

x32 ±0.3125 V
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Figure 19: A/D Calibration for the DT8824
61



Chapter 5

62
Figure 20: A/D Calibration for the DT8824-HV

3. Select the analog input channel to calibrate (AIN1 to AIN4).

Note: At any time, you can click Restore Default to reset the A/D calibration values to 
their original factory settings. This process will undo any manual calibration settings.

4. Select the frequency to use for the calibration (10.0 Hz or 1200 Hz). If you select 10.0 Hz, 
the chopper is enabled for the A/D converter at frequencies equal to or lower than 
960 Hz. If you select 1200, the chopper is disabled for the A/D converter at frequencies 
greater than 960 Hz.

5. Adjust the offset for the selected analog input channel as follows:

a. Select the gain to apply to the channel (1, 8, 16, or 32).

b. Short the analog input channel.
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c. Adjust the offset by entering a value in the Offset edit box, or by clicking the 
up/down arrows, and then click the Write to A/D button.

d. Repeat step 5c until the voltage that is displayed for the selected channel is 0 V.

e. Click the Save calibration button to save the calibration settings.

f. Repeat steps 5a to 5e, selecting the next gain in the list, until the offset value is 
calibrated for each gain setting.

6. Adjust the full-scale range for the selected analog input channel as follows:

a. Select the gain to apply to the channel (1, 8, 16, or 32).

b. Apply the appropriate voltage, shown in Table 4, for the selected gain.

c. Adjust the full-scale range by entering a value in the Full Scale edit box, or by clicking 
the up/down arrows, and then click the Write to A/D button.

d. Repeat step 6c until the voltage that is displayed matches the voltage you supplied.

e. Click the Save calibration button to save the calibration settings.

f. Repeat steps 6a to 6e, selecting the next gain in the list, until the full-scale range is 
calibrated for each gain setting.

7. Repeat steps 4 to 6, selecting the remaining frequency, until the offset and full-scale range 
are calibrated for each gain for the selected channel.

8. Repeat steps 3 to 6 for the remaining A/D channels that you want to calibrate.

If you want a list of all the user calibration and factory default calibration parameters, click the 
Display calibration parameters link at the bottom of the A/D Calibration web page. You can 
then print this page if you wish.

Table 4: Voltages for Calibrating the Full-Scale Range

Gain
DT8824

Voltage to Apply
DT8824-HV

Voltage to Apply

1 9.60000 V 90 V

8 1.20000 V 70 V

16 0.60000 V 35 V

32 0.30000V 17.5 V
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Clock Frequency

Use the Configuration -> Clock web page to configure the scan frequency of the analog input 
subsystem and the reference clock.

A/D Scan Frequency

To configure the scan frequency of the analog input subsystem, do the following: 

1. Select the A/D tab of the Clock web page.

2. Enter a value, in Hertz, between the minimum and maximum shown in the A/D 
Subsystem Clock Frequency field.

Note: The scan frequency that you specify is rounded to the closest "correct" value that 
the instrument module can accept without error. When you save the A/D clock 
configuration, the actual scan frequency is shown.

The DT8824 and DT8824-HV instrument modules use a 4096 sample input FIFO, but start 
transferring data to the host when the input FIFO has 16 samples. If you specify a slow 
sampling frequency, you may experience a long delay before the acquired data is 
available. For example, if you want to acquire data from one channel at a sampling 
frequency of 1.173 Hz, you have to wait 13.6 s (to acquire 16 samples in the input FIFO) 
before you can access the data. The delay is minimized at faster sampling frequencies

3. Click Save changes to apply your changes. If you do not save before leaving this page, 
your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Reference Clock

To configure the reference clock used by the instrument module, do the following: 

1. Select the Reference tab of the Clock web page.

2. For Source, set the reference clock for the instrument module to Internal (the default 
setting) to use the internal reference clock on the instrument module, or LXI7 to use the 
clock from the Trigger Bus.

3. For Output, select LXI7 if you want to drive out the clock on the Trigger Bus, or select 
Disabled (the default setting) if you do not want to drive out the clock signal on the 
Trigger Bus.

4. Click Save changes to apply your changes. If you do not save before leaving this page, 
your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.

Trigger Configuration

Use the Configuration -> Trigger web page to configure the trigger type used by the 
instrument module for starting the analog input subsystem and to drive out a Trigger Bus LXI 
trigger or send a LAN trigger packet.
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A/D Trigger

To configure the trigger source for the analog input subsystem, do the following:

1. Select the A/D tab of the Trigger web page.

2. Select one of the following trigger sources:

− Immediate – A software trigger event occurs when you start the analog input 
operation (the computer issues a write to the instrument module to begin 
conversions). 

− External TTL – An external digital (TTL) trigger event occurs when the instrument 
module detects either a falling-edge or rising-edge on External Trigger line. The trigger 
accepts logic level signals of +5 V and has a triggering threshold of 1.25 V. 

− Trigger Bus – When multiple DT8824 and/or DT8824-HV instrument modules are 
connected together using the Trigger Bus, you can synchronize the start of acquisition 
using one of six LXI trigger signals: LXI0 to LXI5.

− Lan Event – When multiple DT8824 and/or DT8824-HV instrument modules are 
connected together over the local area network (LAN), you can synchronize the start of 
analog input operations by using a LAN trigger packet (0 to 7).

3. Click Save changes to apply your changes. If you do not save before leaving this web 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.

Trigger Bus

To drive out a Trigger Bus LXI trigger or send a LAN trigger packet, do the following:

1. Select the Output tab of the Trigger web page.

2. If you want to drive out a signal on the Trigger Bus, select the LXI line that you want to 
drive out: LXI0 to LXI5.

3. If you want to send out a LAN trigger packet, select the LAN event (LAN0 to LAN7) to 
broadcast.

4. Click Save changes to apply your changes. If you do not save before leaving this web 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.



Verifying the Operation of the DT8824 or DT8824-HV
A/D Buffer Configuration

Use the Configuration -> Buffer web page to configure the buffering mode used by the 
instrument module for analog input operations.

To configure the buffer mode for analog input operations, do the following:

1. Select one of the following buffer modes:

− Wrap – Use this mode if you want the input operation to continue indefinitely. In this 
case, when the end of the input buffer is reached, the operation wraps to the beginning 
of the input buffer overwriting the oldest scan data with the latest scan data.

− Non wrap – Use this mode if you want the input operation to stop automatically when 
the input buffer is filled. The size of this buffer depends on how many channels are 
enabled.

2. Click Save changes to apply your changes. If you do not save before leaving this web 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Measuring Data and Controlling the Instrument
Use the Measurement & control web pages to perform the following functions:

• Start and stop acquisition on the analog input subsystem

• View data in oscilloscope

• View FFT results in a spectrum analyzer

• Download measurements

• Save data to disk

• Control digital outputs

Starting and Stopping a Scan

Use the Measurement & control -> Acquisition web page and click the A/D Start button to 
start the A/D subsystem. You can see the results of your measurements under in an 
oscilloscope view under the Display tab.



Verifying the Operation of the DT8824 or DT8824-HV
Viewing FFT Data

If you want to perform an FFT (Fast Fourier Transform) on the data and view the results in a 
spectrum analyzer display, click the Spectrum tab. A screen similar to the following appears:

You can select from a number of Windowing functions to generate the FFT results. You can 
also choose the units (dB or voltage) for the y-axis.

Note that even after acquisition is aborted, the FFT data points remain on screen for 
post-acquisition analysis. The number of FFT points is determined by the number of channels 
and the sample rate selected.
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Downloading Measurements

To download the raw measurement results to disk, use the Measurement & control -> 
Acquisition web page and select the Download tab.

Note: Only the raw data is downloaded; the FFT results are not saved to disk.

1. Click the Start Download button on this page. Data is fetched from the beginning of the 
buffer and is formatted and displayed in the text area as comma-separated values (CSV). 
This process continues until either you click Stop Download or the end of the buffer is 
reached.

Note: Before you click Start Download, there must be data in the A/D buffer; 
acquisition must be in progress or has been started and aborted.

2. Once download is stopped, click the Save As... button to save this CVS formatted text file 
to a local directory on your computer. You can specify the name of the file and give it any 
extension you want; the contents of the text area are written to the file.



Verifying the Operation of the DT8824 or DT8824-HV
Controlling the Digital Outputs

Use the Measurement & control -> Digital output web page to view the current state of the 
digital output lines, and manually change them if desired. A screen similar to the following 
appears:

Green indicates that the digital output line/relay is closed; red indicates that the digital output 
line/relay is open.

To change the status of a digital output line/relay, click the Open/Close toggle buttons under 
the Control heading for the digital output lines that you want to change.
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Figure 21 shows a block diagram of the DT8824 and DT8824-HV instrument modules. 

Figure 21: Block Diagram of the DT8824 and DT8824-HV Instrument Modules
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Analog Input Features
This section describes the following features of the analog input (A/D) subsystem on the 
DT8824 and DT8824-HV instrument modules:

• Analog input channels, described on page 77

• Input resolution, described on page 77 

• Input ranges and gains, described on page 77

• A/D sample clock, described on page 78

• Input buffer, described on page 79

• Triggers, described on page 80

• Error conditions, described on page 80

Analog Input Channels

The DT8824 and DT8824-HV support four, simultaneous, analog input channels, configured 
differentially. Refer to Chapter 4 for more information on wiring to the analog input channels.

Using software, you enable the channels that you want to sample; channels are numbered 1 to 
4. All analog input channels are simultaneously clocked. 

Note: To maintain simultaneous operation, all analog input connections must have the same 
lead lengths. 

The DT8824 and DT8824-HV use Delta-Sigma analog-to-digital converters (ADCs) that 
provide anti-aliasing filters based on the clock rate. These filters remove aliasing, which is a 
condition where high frequency input components erroneously appear as lower frequencies 
after sampling. 

Input Resolution

The analog input resolution of the DT8824 and DT8824-HV is fixed at 24 bits. 

Input Ranges and Gains

The DT8824 supports a bipolar range of ±10 V. The DT8824-HV supports a bipolar range of 
±600 V. 

In addition, you can choose from up to 4 gains (1, 8, 16, or 32). Table 5 lists the supported gains 
and effective input range of each input range on the DT8824 and DT8824-HV.
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Choose the gain that has the smallest effective range that includes the signal you want to 
measure. For example, if you are using the DT8824 and the range of your analog input signal 
is ±1.05 V, specify a range of ±10 V for the A/D subsystem and use a gain of 8 for the channel; 
the effective input range for this channel is then ±1.25 V, which provides the best sampling 
accuracy for that channel.

A/D Sample Clock

The DT8824 and DT8824-HV support an internal master clock and an internal sync signal that 
synchronizes all the analog-to-digital converters on the instrument module. 

Use software to specify the internal clock source, the internal A/D sync signal, and the 
frequency at which to pace the input operations and to start the sample clock. The sampling 
frequency ranges from 1.173 Hz to 4800 Hz. All channels that are specified in the analog input 
channel list are sampled simultaneously at the specified sampling frequency.

As a guideline, the sampling frequency of the DT8824 and DT8824-HV should be a least 2.5 
times the highest input signal frequency that you are trying to measure. For example, to 
accurately sample a 400 Hz signal, it is recommended that you specify a sampling frequency 
of at least 1000 Hz.

The actual sampling frequency that the instrument module can achieve may be slightly 
different than the frequency you specified due to the accuracy of the clock. You can determine 
the actual clock frequency using software.

Note: The DT8824 and DT8824-HV instrument modules use a 4096 sample input FIFO, but 
start transferring data to the host when the input FIFO has 16 samples. If you specify a slow 
sampling frequency, you may experience a long delay before the acquired data is available. 
For example, if you want to acquire data from one channel at a sampling frequency of 
1.173 Hz, you have to wait 13.6 s (to acquire 16 samples in the input FIFO) before you can 
access the data. The delay is minimized at faster sampling frequencies.

Table 5: Effective Input Ranges 

Gain
Input Range of 

DT8824
Input Range of 

DT8824-HV

1 ±10 V ±600 V

8 ±1.25 V ±75 V

16 ±0.625 V ±37.5 V

32 ±0.3125 V ±18.75 V
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If you are synchronizing analog input operations on multiple DT8824 and/or DT8824-HV 
instrument modules using the Trigger Bus, refer to “Synchronizing Operations on Multiple 
Instrument Modules” on page 83 for more information on the LXI clock and sync signals that 
are needed.

Input Buffer

The DT8824 and DT8824-HV use an 8 MB input buffer for storing data from each of up to 4 
enabled input channels (analog input channels 1, 2, 3, 4). One sample from each of the enabled 
input channels is called a scan.

You can specify one of the following wrap modes for the input buffer in software:

• Continuous wrap mode – Use this mode if you want the input operation to continue 
indefinitely. In this case, when the end of the input buffer is reached, the operation wraps 
to the beginning of the input buffer overwriting the oldest scan data with the latest scan 
data.

• No wrap mode – Use this mode if you want the input operation to stop automatically 
when the input buffer is filled.

Notes: Since the maximum input buffer size is 8 MB and each sample is 4 bytes, you can store 
a maximum of 2 M samples in the input buffer. If you sample each input channel at the 
maximum input frequency (4800 Hz), the input buffer will fill in approximately 106 seconds 
(4800 samples/s per channel).

The maximum size of data transfer over Ethernet is 32 kB. Since each sample is 4 bytes, the 
maximum number of samples that you can transfer at one time is 8 ksamples. Therefore, if 
you are using continuous wrap mode, use a tight loop to ensure that you retrieve all the 
samples in the input buffer before the buffer is overwritten.

Figure 22 illustrates continuous wrap mode using a channel list with four entries: analog input 
channels 1, 2, 3, 4. In this example, data is acquired simultaneously on all channels on each 
clock pulse of the input sample clock. Data is acquired continuously until all the queued 
buffers have been filled or you stop the operation.

Figure 22: Continuous Wrap Mode
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Triggers

A trigger is an event that occurs based on a specified set of conditions. Once the analog input 
subsystem is armed using software (and if the trigger source is immediate, started using 
software), acquisition starts when the instrument module detects the initial trigger event and 
stops when either the input buffer has been filled (if no wrap mode was selected), or you stop 
the operation (if continuous mode is selected).

Note: The Input Trigger LED on the front panel of the DT8824 and DT8824-HV turns solid 
amber when the analog input subsystem is armed and solid green when the analog input 
subsystem is triggered. When the analog input subsystem is idle, the Input Trigger LED is off.

The DT8824 and DT8824-HV support the following trigger sources for starting analog input 
operations:

• Software trigger – A software trigger event occurs when you start the analog input 
operation (the computer issues a write to the module to begin conversions). Using 
software, specify the trigger source as a software trigger.

• External trigger – An external digital trigger occurs when the DT8824 or DT8824-HV 
detects either a falling-edge or rising-edge on the External trigger line. The edge-type is 
software-programmable. 

The external trigger connection is implemented as a differential input with 2 kΩ of 
isolation to the digital ground of the instrument module, allowing for TTL-level or switch 
connections. The trigger accepts logic level signals of +5 V and has a triggering threshold 
of 1.25 V. The positive side is pulled up to +5 V. If you are using the external trigger to 
detect a contact closure, ensure that you configure the polarity of the external trigger for a 
falling-edge (high-to-low) transition.

• Trigger Bus – When multiple DT8824 or DT8824-HV instrument modules are connected 
together using the Trigger Bus, described on page 83, you can receive a trigger from one of 
six LXI trigger signals (LXI0 to LXI5) to synchronize the start of acquisition. 

• LAN Trigger Packet – When multiple DT8824 or DT8824-HV instrument modules are 
connected together over the local area network (LAN), you can synchronize the start of 
analog input operations by using LAN trigger packets. Refer to page 83 for more 
information.

Error Conditions

The DT8824 and DT8824-HV can report an A/D overrun error if the input FIFO overflows. 
The error occurs if the sampling frequency is too fast. The host computer can clear this error. 
To avoid this error, use a slower sampling frequency.
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Digital Output Features
This section describes the following digital output features of the DT8824 and DT8824-HV 
instrument modules:

• Digital output lines, described on page 81

• Channel-to-channel isolation, described on page 81

• Resolution, described on page 82

• Operation modes, described on page 82

Digital Output Lines

The DT8824 and DT8824-HV feature four, latched and isolated digital output lines. The 
outputs are solid-state relays that operate at ±30 V and 400 mA peak (AC or DC). Switching 
time is 2 ms maximum. 

Figure 23 shows the digital output circuitry for each digital output line.

Figure 23: Digital Output Circuitry

Digital outputs resemble a switch; the switch is closed if the state of the digital output line is 1, 
and the switch is open if the state of the digital output line is 0. On power up or reset, the 
digital outputs are disabled. 

Channel-to-Channel Isolation

The DT8824 and DT8824-HV include channel-to-channel isolation of up to ±250 V between 
digital output lines. If you require greater channel-to-channel isolation, use every other digital 
line. This reduces the number of digital lines, but provides channel-to-channel isolation of 
±500 V (one channel can be +500 V while the adjacent channel can be –500 V).
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Resolution

The DT8824 and DT8824-HV provide a resolution of four bits for the digital output port to 
accommodate the four isolated digital output lines. These lines are organized as an isolated, 
dedicated port. You cannot configure port resolution through software. 

Operation Modes

Using software, you can write to a single digital output line or to the entire digital output port. 
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Synchronizing Operations on Multiple Instrument 
Modules

You can synchronize the start of acquisition on multiple instrument modules using LXI 
triggers on the Trigger Bus or LAN trigger packets. If you want the clock to be synchronous, 
you need to use the Trigger Bus. 

Using the Trigger Bus

Up to 16 LXI devices can be connected together using the Trigger Bus. DT8824 and 
DT8824-HV instrument modules may be connected using a daisy-chain configuration, as 
shown in Figure 24, using the 25-pin Trigger Bus connectors, EP377 Trigger Bus cables, and 
Trigger Bus terminators. Both the first device and the last device in the chain must have 
Trigger Bus terminators installed. Terminators must also be installed on both Trigger Bus 
connectors if you are using only one instrument module.

Figure 24: DT8824 and/or DT8824-HV Instrument Modules in a Daisy-Chain Configuration

When multiple DT8824 and/or DT8824-HV instrument modules are connected together using 
the Trigger Bus, you can synchronize the start of acquisition using one of six LXI trigger 
signals: LXI0 to LXI5. As shown in Figure 25, one instrument module is the clock master, 
responsible for driving out the clock signal (LXI7) and sync signal (LXI6) for use by the other 
slave instrument modules. The slave instrument modules must be configured to accept these 
signals.

Note: The order in which you set up the clock and triggers is important; refer to your 
software documentation for more information. While the clock frequencies can be different 
on each instrument module, we recommend that you chooses the same clock frequency for all 
instrument modules. 

EP377 
Trigger Bus 

Cables
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Figure 25: Synchronizing the Start of Acquisition When Connecting Multiple
Instrument Modules to the Trigger Bus

Note: When using LXI triggers, the timing from device to device is guaranteed to be within 
one sample pulse.

Unlike when synchronizing the clock of multiple instrument modules, which requires one 
instrument module dedicated as the clock master, you can have more than one trigger master, 
if desired, to trigger multiple instrument modules. Additionally, the trigger master need not 
be the clock master. Figure 26 shows an example of using two trigger masters on the Trigger 
Bus.

Figure 26: An Example of Using Two Trigger Masters on the Trigger Bus

On the trigger master, use software to set the trigger source to software trigger, external digital 
trigger, or LAN trigger packet (LAN0 to LAN7). Then, use software to drive out the LXI 
trigger signal (LXI0 to LXI5) on the Trigger Bus. 
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Note: While a trigger master can drive out more than one trigger signal on the Trigger Bus, 
the slave can accept only one trigger signal to start the analog input operation.

On each slave, use software to select the trigger signal (LXI0 to LXI5) that was driven out by 
the trigger master on the Trigger Bus and arm the analog input subsystem.

Once the master is armed and triggered, the specified LXI trigger signal is driven out on the 
Trigger Bus to all slaves that were configured to accept it. Acquisition starts on the first sample 
after the trigger is received.

Using LAN Trigger Packets

When multiple DT8824 and/or DT8824-HV instrument modules are connected together over 
the local area network (LAN), as shown in Figure 27, you can synchronize the start of analog 
input operations by transmitting one of eight LAN trigger packets (LAN0 to LAN7) over the 
network. 

Figure 27: Synchronizing the Start of Analog Input Operations When Triggering Instruments 
Modules Over the LAN

The timing of the trigger packets from device to device is dependent on the network traffic on 
the LAN.

The DT8824 and DT8824-HV support multicast transmission of LAN trigger packets using 
UDP (User Datagram Protocol) port 5044 and UDP multicast address 224.0.23.159. The 
DT8824 and DT8824-HV do not support unicast LAN events transmitted via TCP connections.
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Figure 28 shows the format of a LAN trigger packet:

Figure 28: Format of a LAN Trigger Packet

The fields of the LAN trigger packet are described as follows:

• HW Detect – Identifies valid packets and is reserved for future hardware detection of 
LAN events. This field should be set to LXI. Note that the third byte, ASCII "I", is also used 
as a version identifier; future revisions to the LXI standard may change this value.

• Domain – This field represents a group of devices that are managed by a single directory 
and use shared resources. Values for the LXI domain range from 0 to 255. The default 
value is 0. This field is treated as an unsigned byte. 

To transmit LAN trigger packets to or from a DT8824 or DT8824-HV instrument module, 
ensure that you set the domain field of each DT8824 or DT8824-HV instrument module to 
the same value using software.

• Event ID – This field contains the first 16 bytes of the event name (a string). By default, the 
LAN event names are defined as LAN0 to LAN7. 

To transmit LAN trigger packets to or from a DT8824 or DT8824-HV instrument module, 
ensure that you set the event ID of each DT8824 or DT8824-HV instrument module to the 
same value using software.

• Sequence – Each instrument module maintains its own sequence; the sequence number is 
incremented every time a unique packet is transmitted. (Note that if packets are 
retransmitted to enhance reliability, re-transmitted packets contain the same sequence 
number as the original.)

• Time stamp – For DT8824 and DT8824-HV instrument modules, the time stamp of 
received LAN event packets is ignored, while generated LAN event packets have a time 
stamp of 0. 

• Epoch – For DT8824 and DT8824-HV instrument modules, this value is 0.

• Flags – Contains data about the packet. This value is generated automatically by DT8824 
and DT8824-HV instrument modules.

• Data Fields – Arbitrary number of bytes, up to the capacity of the data packet. This field is 
generated automatically by DT8824 and DT8824-HV instrument modules.
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To trigger analog input operations on a DT8824 or DT8824-HV using a LAN trigger packet, set 
up the domain and the event ID of the LAN trigger packet, as described on page 86, and then 
do the following:

1. Use software to set the trigger source for the analog input subsystem of each DT8824 or 
DT8824-HV to the enabled LAN trigger packet (LAN0 to LAN7).

2. Enable the LAN event (LAN0 to LAN7) for transmission using software.

3. Specify the destination or source address for the enabled LAN event (LAN0 to LAN7) 
using software.

4. Arm the analog input subsystem.

Acquisition starts with the first sample after the specified LAN trigger packet is received.
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General Checklist
Should you experience problems using a DT8824 or DT8824-HV, do the following: 

1. Read all the documentation provided for your product, including any “Read This First” 
information.

2. Check the DT8824 CD for any README files and ensure that you have used the latest 
installation and configuration information available.

3. Check that your system meets the requirements as stated in the README file on the 
DT8824 CD.

4. Check that you have installed your hardware properly using the instructions in Chapter 
3.

5. Check that you have wired your signals properly using the instructions in Chapter 4.

6. Check that you have installed Java and configured your web browser appropriately using 
the instructions on page 49.

7. Search the DT Knowledgebase in the Support section of the Data Translation web site (at 
www.mccdaq.com) for an answer to your problem. 

If you still experience problems, try using the information in Table 6 to isolate and solve the 
problem. If you cannot identify the problem, refer to page 92. 

Table 6: Troubleshooting Problems 

Symptom Possible Cause Possible Solution

DT8824 or 
DT8824-HV is 
not found.

The DT8824 or 
DT8824-HV cannot 
communicate with the 
network. 

Ensure that your DT8824 or DT8824-HV is properly connected; see 
the instructions in Chapter 3.

If your PC has a static IP address, reconfigure it for Auto-IP using the 
instructions on Appendix C.

Check the LAN configuration of the instrument module; see the 
instructions in Chapter 3.

Check the IP address of the instrument module by opening a 
Command Prompt window (Start -> Programs -> Accessories -> 
Command Prompt) and entering the command 
"ipconfig /all". The IP settings of your instrument module are returned.

Ping the instrument module by opening a Command Prompt window 
(Start -> Programs -> Accessories -> Command Prompt) and entering 
the command "ping address", where address is the IP address of your 
instrument module. If a timeout message is returned, the IP address is 
incorrect. If a "no host" error message is returned, the subnet mask is 
incorrect. Refer to Appendix C for more information on IP and subnet 
addresses.

If needed, reset the instrument module using the instructions on
page 38.
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DT8824 or 
DT8824-HV 
does not 
respond.

The configuration is 
incorrect.

Check the LAN configuration of your instrument module; see the 
instructions in Chapter 3.

Check the IP address of the instrument module by opening a 
Command Prompt window (Start -> Programs -> Accessories -> 
Command Prompt) and entering the command "ipconfig /all". The IP 
settings of your instrument module are returned.

Ping the instrument module by opening a Command Prompt window 
(Start -> Programs -> Accessories -> Command Prompt) and entering 
the command "ping address", where address is the IP address of your 
instrument module. If a timeout message is returned, the IP address is 
incorrect. If a "no host" error message is returned, the subnet mask is 
incorrect. Refer to Appendix C for more information on IP and subnet 
addresses.

If needed, reset the instrument module using the instructions on 
page 38.

The instrument module is 
damaged.

Contact Data Translation for technical support; refer to page 92.

Intermittent 
operation.

Loose connections or 
vibrations exist.

Check your wiring and tighten any loose connections or cushion 
vibration sources; see the instructions in Chapter 4.

The instrument module is 
overheating.

Check environmental and ambient temperature; consult the 
specifications on page 103 and the documentation provided by your 
computer manufacturer for more information.

Electrical noise exists. Check your wiring and either provide better shielding or reroute 
unshielded wiring; see the instructions in Chapter 4.

Data appears 
to be invalid.

An open connection 
exists.

Check your wiring and fix any open connections; see the instructions in 
Chapter 4.

A transducer is not 
connected to the channel 
being read.

Check the transducer connections; see the instructions in Chapter 4.

The channel configuration 
does not match the 
software configuration for 
that channel.

Check your wiring and ensure that what you specify in software 
matches your hardware configuration; see the instructions in Chapter 
4.

The instrument module 
may need recalibration. 

The DT8824 and DT8824-HV are calibrated at the factory. Thereafter, 
yearly calibration is recommended using the DT8824 web application, 
described in Chapter 5.

Table 6: Troubleshooting Problems  (cont.)

Symptom Possible Cause Possible Solution
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Technical Support 
If you have difficulty using a DT8824 or DT8824-HV, Data Translation’s Technical Support 
Department is available to provide technical assistance. 

To request technical support, go to our web site at http://www.mccdaq.com and click on the 
Support link. 

When requesting technical support, be prepared to provide the following information:

• Your product serial number

• The hardware/software product you need help on

• The version of the CD you are using

• Your contract number, if applicable

If you are located outside the USA, contact your local distributor; see our web site 
(www.mccdaq.com) for the name and telephone number of your nearest distributor.
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If Your Instrument Module Needs Factory Service 
Most hardware models can be functionally tested, evaluated for repairs (if needed), and calibrat
factory specifications. An RMA # must be obtained from Application Engineering in advance of 
sending any product back to Measurement Computing. Customers outside the USA must contac
their local distributor for a return procedure. Calibration certificates for most analog models can
obtained for a fee (certificate must be requested at time of RMA # assignment).
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Analog Input Specifications
Table 7 lists the specifications for the A/D subsystem on the DT8824 and DT8824-HV 
instrument modules.

Table 7: A/D Subsystem Specifications 

Feature DT8824 Specifications DT8824-HV

umber of analog inputs 4 Differential 4 Differential

umber of gains 4 (1, 8, 16, 32) 4 (1, 8, 16, 32) 

put range
Gain = 1:
Gain = 8:
Gain = 16:
Gain = 32:

±10 V
±1.25 V
±0.625 V
±0.3125 V

±600 V
±75 V
±37.5V
±18.75 V

esolution 24 bits 24 bits

ata encoding Offset binary Offset binary

oupling DC DC

mple frequency per channel 1.173 Hz to 4800 Hz 1.173 Hz to 4800 Hz

stem accuracy @ 10 Hz
ll-scale = 10 V for DT8824; 600 V for DT8824-HV))

Gain = 1:
Gain = 8:
Gain = 16:
Gain = 32:

0.001%
0.002%
0.003%
0.005%

0.008%
0.008%
0.012%
0.020%

stem accuracy @ 100 Hz
ll-scale = 10 V for DT8824; 600 V for DT8824-HV)

Gain = 1:
Gain = 8:
Gain = 16:
Gain = 32:

0.001% 
0.002% 
0.003% 
0.006% 

0.008%
0.008%
0.012%
0.024%

stem accuracy @ 1200 Hz
ll-scale = 10 V for DT8824; 600 V for DT8824-HV) 

Gain = 1:
Gain = 8:
Gain = 16:
Gain = 32:

0.001%
0.002%
0.004%
0.007%

0.008%
0.008%
0.016%
0.028%

stem accuracy @ 4800 Hz
ll-scale = 10 V for DT8824; 600 V for DT8824-HV))

Gain = 1:
Gain = 8:
Gain = 16:
Gain = 32:

0.001%
0.003%
0.005%
0.010%

0.008%
0.008%
0.02%
0.04%

onlinearity (integral)
Gain = 1:
Gain > 1:

±5 ppm full-scale maximum
±15 ppm full-scale maximum

±25 ppm full-scale maximum
±35 ppm full-scale maximum

ifferential linearity ±1 LSB (no missing codes) ±1 LSB (no missing codes)
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ffset drift versus temperature
≤ 600 Hz:
 600 Hz:

50 nV/°C 
150 nV/°C

3 μV/°C 
9 μV/°C

ffset drift versus time 25 nV/1000 hours typical 1.5 μV/1000 hours typical

ain drift versus temperature ±10 ppm/°C ±25 ppm/°C 

ain drift versus time 10 ppm/1000 hours typical 25 ppm/1000 hours typical

put impedance
Power off:
Power on:

3 kΩ 
10 MΩ// 3 kΩ in series with
4700 pF

3 kΩ 
1 MΩ// 3 kΩ in series with
4700 pF

put bias current ≤ ±1 nA ≤ ±1 nA

put noise (@10 Hz sample rate; gain of 1) 3.6 μV rms = 23.8 μV pp or 
< 1.5 ppm 

209.0 μV rms = 1.4 mV pp or 
< 1.5 ppm 

stem noise See Table 8 and Figure 29 on 
page 98

See Table 9 and Figure 30 on 
page 99

alog input filter 3 kHz 3 kHz 

ommon mode rejection @ 10 Hz > –150 dB @ 50 Hz and 60 Hz > –150 dB @ 50 Hz and 60 Hz

ommon mode voltage ±500 V maximum (operational) ±1000 V maximum (operational

aximum input voltage ±40 V maximum (protection) ±800 V maximum (protection)

hannel-to-channel offset ±10 μV ±600 μV

fective number of bits (ENOB)
100 Hz with a 10 Hz, ±9.9 V sine wave input 21 bits typical 20 bits typical

hannel crosstalk –150 dB @ 1 kHz –150 dB @ 1 kHz

put coupling DC DC

olation voltage ±500 V to computer ground ±1000 V to computer ground 

hannel-to-channel isolation ±500 V ±2000 V 

D protection 
Arc:
Contact:

8 kV
4 kV

8 kV
4 kV

ternal reference 1.25 V ±0.001 V 1.25 V ±0.001 V

 dB point (low pass)a

Sample rate less than or equal to 600 Samples/s
Sample greater than 600 Samples/s

f −3 dB = 0.24 x fADC
f −3 dB = 0.23 x fADC

f −3 dB = 0.24 x fADC
f −3 dB = 0.23 x fADC

ternal clock ±100 ppm maximum (typical 
initial ±25 ppm)b 

±100 ppm maximum (typical 
initial ±25 ppm)b

arm-up time 1 hour 1 hour 

efer to page 100 for more information about the frequency response, input bandwidth, and correction factors.
his clock is derived from the crystal oscillator. The specification includes initial tolerance, power supply variations, temperature drift, 
nd 1 year stability.

Table 7: A/D Subsystem Specifications  (cont.)

Feature DT8824 Specifications DT8824-HV
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System Noise Of the DT8824

Table 8 lists the typical RMS noise, in microvolts, of the DT8824 at sampling rates of 
10 Samples/s, 100 Samples/s, 960 Samples/s, and 4800 Samples/s and gains of 1, 8, 16, and 
32.

Figure 29 shows this data in graphical form.

Figure 29: System Noise Specification for the DT8824

Table 8: DT8824 System Noise

Gain 10 Samples/s 100 Samples/s 960 Samples/s 4800 Samples/s

1 3.6 μVrms 12.0 μVrms 25.0 μVrms 63.0 μVrms

8 0.7 μVrms 2.0 μVrms 4.2 μVrms 11.0 μVrms

16 0.6 μVrms 1.8 μVrms 2.8 μVrms 7.5 μVrms

32 0.4 μVrms 1.3 μVrms 2.3 μVrms 6.5 μVrms

0.0
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50.0

60.0

70.0

10 100 960 4800
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Data Rate, SPS
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Gain=8
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System Noise Of the DT8824-HV

Table 9 lists the typical RMS noise, in microvolts, of the DT8824-HV at sampling rates of 
10 Samples/s, 100 Samples/s, 960 Samples/s, and 4800 Samples/s and gains of 1, 8, 16, and 
32.

Figure 30 shows this data in graphical form.

Figure 30: System Noise Specification for the DT8824-HV

Table 9: DT8824-HV System Noise

Gain 10 Samples/s 100 Samples/s 960 Samples/s 4800 Samples/s

1 209.0 μVrms 680.0 μVrms 1470.0 μVrms 3760.0 μVrms

8 71.0 μVrms 209.0 μVrms 475.0 μVrms 1100.0 μVrms

16 63.0 μVrms 200.0 μVrms 435.0 μVrms 960.0 μVrms

32 58.0 μVrms 185.0 μVrms 415.0 μVrms 930.0 μVrms

0.0

500.0

1000.0

1500.0

2000.0

2500.0

3000.0

3500.0

4000.0

10 100 960 4800

uVrms

Data Rate, SPS

DT8824-HV System Noise

Gain =1

Gain=8

Gain=16

Gain=32
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Frequency Response and Input Bandwidth

Each channel of the DT8824 and DT8824-HV instrument modules include a dedicated 24-bit 
Sigma-Delta A/D converter. The ultra-low noise and accuracy of these converters is achieved 
using an oversampling Sigma-Delta modulator followed by a multi-order Sinc filter and a 
digital low-pass filter/decimator. 

The filter response has a gentle rolloff from DC with a 3 dB signal bandwidth that is 
determined by the user-selected sampling rate, shown in Table 10.

Figure 31 shows the frequency response using a sampling rate of 4800 Samples/s.

Figure 31: Frequency Response of the DT8824 and DT8824-HV When Using a 
Sampling Rate of 4800 Samples/s 

Table 10: −3 dB Bandwidth

Sampling Frequency −3 dB Bandwidth Point

Less than or equal to 600 Samples/s 0.24 x sample rate

Greater than 600 Samples/s 0.23 x sample rate

–3 dB point = 1104 Hz
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As you can see, the frequency response of the DT8824 and DT8824-HV gently rolls off from 
DC due to the filtering of the Sigma-Delta A/D converter. You can use software to apply a 
correction factor to the acquired data to compensate for the filter response of the A/D 
converter. The correction factor depends on the input frequency of the signal you are trying to 
measure and the sampling rate of the instrument module. Table 11 shows the gain correction 
factors for typical input frequencies and sampling rates.

Table 11: Gain Correction Factors 

quency 
he Input 
nal (Hz)

Sampling Rate of the DT8824 or DT8824-HV

10 
Samples/s

25 
Samples/s

60 
Samples/s

100 
Samples/s

600 
Samples/s

960 
Samples/s

1600 
Samples/s

4800 
Samples

1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

1.257 1.035 1.006 1.002 1.000 1.000 1.000 1.000

– 3.456 1.168 1.056 1.001 1.001 1.000 1.000

– – – – 1.038 1.017 1.006 1.001

– – – – 1.055 1.024 1.008 1.001

– – – – 1.167 1.068 1.023 1.003

– – – – 2.087 1.304 1.095 1.011

– – – – – 6.040 1.791 1.073

0 – – – – – – – 1.325

0 – – – – – – – 3.158
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Digital Output Specifications
Table 12 lists the specifications for the digital output (DOUT) subsystem on the DT8824 and 
DT8824-HV. 

Table 12: Digital Output Specifications 

Feature
DT8824 and DT8824-HV

Specifications

Number of digital output lines 4 isolated outputs

Number of ports 1, 4-bit output port

Outputs 
Output type: 
Output driver: 
High output: 
Low output: 
Breakdown voltage: 
Contact impedance: 

Solid-state relay 
CMOS 
± 30 V 
0.4 V @ 400 mA 
± 60 V 
1 Ω 

Isolation voltage 
To computer ground: 
Channel to channel 

±500 V
±250 Va

a. Determined by the pin spacing in the 37-pin digital connector. For greater 
channel-to-channel isolation, use every other digital line; using every other 
digital line allows ±500 V isolation channel-to-channel.



Specifications

P
 
 
 

P

E
 
 
 

Power, Physical, and Environmental Specifications
Table 13 lists the power, physical, and environmental specifications for the DT8824 and 
DT8824-HV. 

Table 13: Power, Physical, and Environmental Specifications 

Feature DT8824 Specifications DT8824-HV Specifications

ower
   +5 V Standby:
   +5 V Enumeration:
   +5 V Power ON:

Power Consumption: 

500 μA maximum
100 mA maximum (75 mA typical)
500 mA maximum (420 mA typical)
425 mA current draw 

500 μA maximum
100 mA maximum (75 mA typical)
500 mA maximum (420 mA typical)
425 mA current draw 

hysical Dimensions
Width:
Length:
Height:
Weight: 

8.380 inches (212.85 mm)
9.319 inches (236.7 mm)
1.720 inches (43.69 mm)
31 ounces (880 g)

8.380 inches (212.85 mm)
9.319 inches (236.7 mm)
1.720 inches (43.69 mm)
31 ounces (880 g)

nvironmental
  Operating temperature range:
  Storage temperature range:
  Relative humidity:

0° C to 55° C
–25° C to 85° C
To 95%, noncondensing

0° C to 55° C
–25° C to 85° C
To 95%, noncondensing
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Regulatory Specifications
The DT8824 and DT8824-HV are CE-compliant. Table 14 lists the regulatory specifications for 
the DT8824 and DT8824-HV.

Table 14: Regulatory Specifications 

Feature Specifications

Emissions (EMI) FCC Part 15, Class A
EN55011:2007 (Based on CISPR-11, 2003/A2, 2006)

Immunity EN61326-1:2006 
Electrical Equipment for Measurement, Control, and Laboratory Use

EMC Requirements
EN61000-4-2:2009
Electrostatic Discharge (ESD) 4 kV contact discharge,
8 kV air discharge, 4 kV horizontal and vertical coupling planes

EN61000-4-3:2006
Radiated electromagnetic fields, 3 V/m, 80 to 1000 MHz; 
3 V/m, 1.4 GHz to 2 GHz; 1 V/m, 2 GHz to 2.7 GHz

EN61000-4-4:2004
Electrical Fast Transient/Burst (EFT) 1 kV on data cables

EN61000-4-6:2009
Conducted immunity requirements, 3 Vrms on data cables
150 kHz to 80 MHz

RoHS (EU Directive 2002/95/EG) Compliant (as of July 1st, 2006)
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Connector Specifications
Table 15 lists the cable and connector specifications for the DT8824 and DT8824-HV.

Table 15: Connector Specifications

Feature DT8824 and DT8824-HV Specifications

RJ45 Ethernet Connector Bothhand part number LU1S041C-43-LF

Digital Input/Output Connector Tyco part number 5747845-4

4-Position Screw Terminal Block Header: Phoenix Contact 1803293 
Plug: Phoenix Contact 1803594

Trigger Bus Connectors Molex part number 83619-9011
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External Power Supply Specifications
Table 16 lists the specifications for the EP361 +5 V external power supply that is used with the 
DT8824 and DT8824-HV.

Table 16: External Power Supply (EP361) Specifications 

Feature Specifications

Type Total Power medical power supply (TPES22-050400 or 
TPEMG24-S050400-7)

Input voltage Typical 90 - 264 V AC 

Input current
TPES22-050400

TPEMG24-S050400-7

Typical 0.38 A at 115 V AC, 0.15 A at 230 V AC

Typical 0.347 A at 115 V AC, 0.215 A at 230 V AC

Frequency 47 to 63 Hz

Inrush current
TPES22-050400

TPEMG24-S050400-7

35 A at 230 V AC typical or less than 30 A by adding 
thermistor

6.274 A RMS at 230 V AC 

Output voltage 5 V DC

Output current 4.0 A

Output wattage
TPES22-050400

TPEMG24-S050400-7

Typical 22 - 24 W

Typical 20 - 24 W

Noise and ripple 1% peak to peak

Regulatory specifications
TPES22-050400

TPEMG24-S050400-7

UL, N, CE, FCC Class B

UL, ITE, CE, FCC Class B, Energy Star compliant
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Connector Pin Assignments
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Analog Input Screw Terminals
Figure 32 shows the terminal blocks for each analog input channel on the DT8824 and 
DT8824-HV instrument modules.

Figure 32: Screw Terminals of the Analog Input Channels

Table 17 summarizes the screw terminal assignments.

Table 17: Screw Terminal Assignments for the Analog Input Channels

Screw Terminals Signal Description

1 Analog Input +

2 Not Connected

3 Analog Input –

4 Analog Ground

4 3 2 1



Connector Pin Assignments
Digital I/O Connector
Figure 33 shows the pin locations of the digital I/O connector on the DT8824 and DT8824-HV.

Figure 33: Digital I/O Connector

Table 18 lists the pin assignments of the digital I/O connector.

Note: The outer shell of the connector provides the cable shield to chassis ground.

Table 18: Digital I/O Connector Pin Assignments 

Pin Signal Description Pin Signal Description

1 External Trigger High 9 External Trigger Low

2 No Connect 10 Digital Ground

3 No Connect 11 Digital Ground

4 Digital Output 0 A 12 Digital Output 0 B

5 Digital Output 1 A 13 Digital Output 1 B

6 Digital Output 2 A 14 Digital Output 2 B

7 Digital Output 3 A 15 Digital Output 3 B

8 No Connect
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RJ45 (LVDS) Ethernet Connector
Figure 34 shows the RJ45 (LVDS) Ethernet connector. 

Figure 34: RJ45 (LVDS) Ethernet Connector

Table 19 lists the pin assignments for the RJ45 (LVDS) Ethernet connector on the DT8824 and 
DT8824-HV.

 
Table 19: RJ45 (LVDS) Ethernet Connector Pin Assignments 

Pin Description

1 TX +

2 TX –

3 RX + 

4 Reserved

5 Reserved

6 RX –

7 Reserved

8 Reserved



Connector Pin Assignments
External 5V DC Connector
Figure 34 shows the 5 V DC connector. 

Figure 35: 5 V DC Connector

Table 19 lists the pin assignments for the 5 V DC connector on the DT8824 and DT8824-HV.

 
Table 20: 5 V DC Connector Pin Assignments 

Pin Description Pin Description

1 +5 V 3 GND

2 +5 V 4 GND
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LXI Wired Trigger Bus Connector
Figure 34 shows the LXI Wired Trigger Bus connector. 

Figure 36: 5 V DC Connector

Table 19 lists the pin assignments for the LXI Wired Trigger Bus connector on the DT8824 and 
DT8824-HV.

 
Table 21: LXI Wired Trigger Bus Connector Pin Assignments 

Pin Description Pin Description

1 +3.3 V 14 Signal 0+

2 +3.3 V Return 15 Signal 0–

3 Signal 1+ 16 Reserved

4 Signal 1– 17 Signal 2+

5 GND 18 Signal 2–

6 Signal 3+ 19 GND

7 Signal 3– 20 Signal 4+

8 GND 21 Signal 4–

9 Signal 5+ 22 GND

10 Signal 5– 23 Signal 6+

11 Reserved 24 Signal 6–

12 Signal 7+ 25 Reserved

13 Signal 7–
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Configuring Network Settings

on Your PC
Configuring the PC to Use Auto-IP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
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Configuring the PC to Use Auto-IP
Once your DT8824 or DT8824-HV is connected to the LAN and powered on, the instrument 
module automatically requests an Ethernet address from a DHCP (Dynamic Host 
Configuration Protocol) server, if available, and a host name from a DNS (Dynamic Domain 
Name Service) server, if available. 

If these services are not available on the LAN, the instrument module uses Auto-IP to set up 
its TCP/IP configuration. In this case, the IP address will be in the range of 169.254.0.0 to 
169.254.255.255 with a subnet mask of 255.255.255.0.

If your LAN does not support a DHCP server and your PC is configured to use a static IP 
address, you must temporarily reconfigure the PC to use Auto-IP before setting up the 
DT8824 or DT8824-HV using the following procedure.

Note: This procedure may differ slightly depending on your computer and the version of 
Windows you are using. Windows XP instructions are shown here. Consult your system 
administrator and/or the documentation for your operating system if you need additional 
help.

1. From the Windows Start menu, click Settings, and then click Network Connections.

2. Right-click Local Area Connection, and select Properties.

3. In the General tab window, double-click Internet protocol (TCP/IP). 
(If a TCP/IP selection is not listed, click Install, select Protocol, click Add, select the 
TCP/IP protocol, and click Install, and repeat step 3).



Configuring Network Settings on Your PC
4. IMPORTANT: Write down the IP address and subnet mask that is displayed! You will 
need this information later.

5. Select Obtain an IP address automatically, and then click OK.

6. Select the Alternate Configuration tab, and ensure that Automatic private IP address is 
selected.
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7. Renew the IP address of the computer. From the Windows Start menu, click Settings 
->Network Connections -> Local Area Connection -> Support -> Repair. 

Or, if you prefer to do this from the command prompt window, click Run from the 
Windows Start menu, enter cmd, and click OK to bring up the command prompt window. 
Then, from the command prompt window, enter:

ipconfig /renew renews the IP address
ipconfig /all checks the IP address



Configuring Network Settings on Your PC
Specifying a Static IP Address for the DT8824 or 
DT8824-HV

To specify a static IP address for the DT8824 or DT8824-HV, use the LAN Configuration page 
of the web interface as follows:

1. From the LAN Configuration page, click Modify.

2. Specify the username as admin, and specify the password (the default is admin). You can 
change the password, if you desire.

3. Uncheck the checkbox called Automatic private IP address enabled.

4. Click Static. 

5. Specify a static IP address for the DT8824 or DT8824-HV, so that is will be on the same 
subnet as your PC:

 

Note: You need a Simple Network Time Protocol (SNTP) time server on the LAN; otherwise, 
you need to provide a gateway. See your network administrator for more details.
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Reconfiguring the PC to Use a Static IP Address
After you have set up your DT8824 or DT8824-HV, you can reconfigure your PC to use a static 
IP address.

Note: This procedure may differ slightly depending on your computer and the version of 
Windows you are using. Windows XP instructions are shown here. Consult your system 
administrator and/or the documentation for your operating system if you need additional 
help.

1. From the Windows Start menu, click Settings, and then click Network Connections.

2. Right-click Local Area Connection, and select Properties.

3. In the General tab window, double-click Internet protocol (TCP/IP). 

4. Select Use the following IP address:, specify the static IP address and subnet mask that 
was initially assigned to the PC (see page 114), and click OK.

5. Renew the IP address of the computer. From the Windows Start menu, click Settings 
->Network Connections -> Local Area Connection -> Support -> Repair. 

Or, if you prefer to do this from the command prompt window, click Run from the 
Windows Start menu, enter cmd, and click OK to bring up the command prompt window. 
Then, from the command prompt window, enter:

ipconfig /renew renews the IP address
ipconfig /all checks the IP address



D
Using the Bonjour Discovery Utility
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If you wish, you can use the Bonjour utility from Apple®, rather than the Eureka utility to 
discover devices on your network.

Once you have downloaded and installed the Bonjour SDK from Apple 
(http://developer.apple.com/opensource/), open your browser, and then open the Bonjour 
Explorer bar. To do this using Internet Explorer, for example, follow these steps:

1. From Internet Explorer, click the View menu.

2. Click Explorer Bars.

3. Click Bonjour.
A list of devices on the network appears in the left pane.

4. Double-click the DT8824 or DT8824-HV device to see the web pages for that instrument 
module.
A screen similar to the following appears:



Using the Bonjour Discovery Utility
Note that Bonjour automatically resolves the hostname and description.

The Bonjour/mDNS resolved Hostname is the user-configured hostname appended with 
.local. You can use the resolved Hostname instead of the device’s IP address to communicate 
with the device. The hostname does not change unless more than one device is configured 
with the same hostname. This feature is especially useful when IP addresses are assigned by 
DHCP and may change.

If more than one device is configured with the same Hostname and/or Description/Service 
name, Bonjour resolves each hostname by appending a number to the configured Hostname 
and/or Description/Service name. In this case, the LAN configuration page and the Device 
Info page show the unique Hostnames and Description/Service names.
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ISO-Channel Technology
DT8824 and DT8824-HV instrument modules use ISO-Channel™ technology to eliminate 
common mode noise and ground loop problems.

This appendix includes two white papers that describe the benefits of using ISO-Channel 
technology.



About ISO-Channel Technology
Why ISO-Channel Technology 
is Your Best Return on Investment

When connecting signal sources to an instrument, it is important to eliminate the sources of 
error that can contribute to inaccuracies in your measurements. In most measurement 
instruments, this burden is on the customer. Instruments that use ISO-Channel technology, 
however, solve this problem for you – saving you tremendous setup and debug time and 
reducing costly grounding problems when connecting signals.

In today’s economy, we understand that every equipment decision needs to make good fiscal 
sense. This section describes why instruments with ISO-Channel technology offer you the best 
return on investment.

Understanding Ground Loops

When measuring signals, users often assume that the grounds of their signals and their 
measurement system are at the same potential. However, these ground potentials can differ by 
hundreds of millivolts.

If the difference in ground potential is large enough, current flows between the signal and 
your measurement system; this is called a ground loop (see Figure 37). Ground loops 
contribute noise that can greatly affect the accuracy of your measurements, especially when 
you are trying to measure low level signals precisely. Ground loop problems are the most 
common source of error in all measurements! Eliminating these errors, therefore, is critical 
when taking high accuracy measurements.

Figure 37: Measurement System with a Ground Loop

When a ground loop 
exists, the measured 
voltage, Vout, is the 
sum of the signal 
voltage, Vsource, and 
the ground potential 
difference, Vcm, which 
exists between the 
signal source ground 
and the measurement 
system ground. These 
errors often appear as 
transients or periodic 
signals in the 
measurement. For 
example, if a ground 
loop is formed with 50 
Hz or 60 Hz AC power 
lines, the unwanted AC 
signal appears as a 
periodic voltage error in 
the measurement.
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ISO-Channel Eliminates Ground Loops and Increases 
Common-Mode Rejection

ISO-Channel technology eliminates ground loop problems by using a differential, isolated, 
floating front-end. As you can see in Figure 38, a floating voltage signal is not referenced to 
system ground. 

Figure 38: Floating Signals

To measure floating signal sources, ISO-Channel technology uses differential analog input 
signals, a 24-bit Delta-Sigma A/D converter for each channel, and channel-to-channel 
isolation, as shown in Figure 39. 



About ISO-Channel Technology
Figure 39: ISO-Channel Technology

Floating, Differential Signals

ISO-Channel technology implements a virtually ideal differential measurement system that 
reads only the potential difference between the positive and negative terminals of the 
amplifier. For each channel, the differential signals are isolated in that they are referenced to a 
ground reference point that is not connected to earth ground. Ground loop problems are 
eliminated by ensuring that only one ground reference is used for each channel in the 
measurement system. The signal sources are isolated from each other and from the 
measurement instrument.
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Figure 40: Differential Signals and Common-Mode Voltage

When the measurement instrument and signal source are at different ground potentials, the 
difference in potential is called common-mode voltage. The measurement instrument cannot 
discern between the signal and the common-mode voltage believing that the sum of these 
voltages is the actual signal. Of course, the common-mode potential is simply an error.

ISO-Channel technology provides common-mode rejection of 150 dB, which contributes an 
almost imperceptible error (33.5 million to 1) to Vout. Compare this to traditional data 
acquisition measurement instruments, which typically provide only 80 dB of common-mode 
rejection and therefore, contribute much more error on the order of 1 part per 10,000. 

Simultaneous Architecture

Many measurement instruments on the market today provide multiplexed architectures, 
where one A/D is used to measure multiple channels. In this kind of architecture, if one 
channel goes down, all channels go down.

ISO-Channel technology, on the other hand, uses a simultaneous architecture, where each 
channel has its own dedicated 24-bit Delta-Sigma A/D, as shown in Figure 41.
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Figure 41: Simultaneous vs. Multiplexed Architectures

Channel-to-Channel Isolation

Besides differential inputs, floating channels, and a simultaneous architecture, ISO-Channel 
technology provides channel-to-channel isolation, not just isolation from the analog front-end 
to the computer ground. With this kind of isolation, the channels are individually isolated 
from each other and from other system components. 

Typically, instrument manufacturers have used relays, isolation amplifiers, or optical isolation 
to provide channel-to-channel isolation. These methods have the following advantages and 
limitations:

• Relays – This technology provides good galvanic separation and can provide good 
accuracy and thermal properties, but relays are slow as they operate on one channel at a 
time (10 cycles/s), wear out over time, and are sensitive to magnetic fields. If one relay 
sticks, staying closed, the entire system fails! 

• Isolation amplifiers – Isolation amplifiers are used in multiplexed architectures. While 
they are solid-state, they are expensive, not as accurate, require more power, and generate 
more noise and heat than other solutions. 

• Optical isolation - Optical isolation is good in digital isolation systems but causes accuracy 
problems in analog isolation systems. It is also subject to long-term drift and requires 
considerably more power.

With ISO-Channel technology, the A/D is on the sensor side and has its own custom DC/DC 
converter. Then, optical or transformer isolation is used to transfer the A/D output data (the 
sensor data) digitally. And, due to the simultaneous architecture of ISO-Channel technology, 
all data is transferred in parallel.
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Summary

ISO-Channel technology offers built in system redundancy to protect your investment - if one 
channel fails, the remaining channels are completely unaffected! Instruments with 
ISO-Channel technology also adapt to the sensors that they are connected to, allowing a 
different ground reference for each signal without introducing errors! For these key reasons, 
ISO-Channel technology protects against problems in the field, and thereby, reduces costs – 
what a great return on your investment.
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Floating Signal Inputs Offer New Application 
Advantages

Precision measurement systems are often limited in that all inputs are connected to a single 
ground. Typically, multiplexer input configurations are set up this way, since all signal inputs 
are connected to the same return. Even differential input configurations use the same ground 
reference. The result is that accuracy and flexibility for accurate measurements can be severely 
compromised when noise or common mode voltage is present (see Figure 42).

Figure 42: In multiplexed systems, all inputs are connected to a signal ground, which can cause 
errors when noise or common mode voltage is present.

Crosstalk from one input signal can easily be reflected onto another input. The design 
movement to an A/D per channel can help this problem. But that is not sufficient in many 
cases (see Figure 43).
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Figure 43: Even when using an A/D per channel, noise can contribute errors to your measurement 
results.

To minimize noise and ground loops, some newer systems offer isolation between the input 
signal ground reference and the computer ground. This effectively separates the computer 
ground from the measurement portion of the system. But still, there is no isolation between 
input sensor channels, which is a common source of error and frustration for user 
applications. Why?

The assumption is made that all signal sources have the same exact ground reference. After 
all…ground is ground…isn’t it? Often this is not the case. For example, thermocouples for 
measuring temperature may be dispersed widely throughout an industrial setting, such as in 
the manufacture of air frames or in curing ovens. Grounds for these sensors may differ by 
several volts or even hundreds of volts. The resulting common mode voltage causes current to 
flow in the signal path, producing serious errors, which are very hard to diagnose and correct.

Isolating Each Input

Oftentimes it is NOT apparent that ground references from various sensors such as 
thermocouples, RTDs, strain gages, etc., are at different voltage potentials. Factors that can 
contribute to these ground differences are extensive wiring from long runs, crosstalk from 
motors or generators, or high source impedance from the signal source. Without recognizing 
this extraneous voltage, the measurement system “sees” this noise or common mode voltage 
as the actual signal. These unwanted noise sources lead to measurement errors (see Figure 44).
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Figure 44: Common mode voltage is present when different ground potentials exist in your 
measurement system.

In many applications, noise is a fact and a common occurrence. To prevent this noise from 
entering the signal path, the signal must be isolated on a channel-to-channel basis as well as 
from the PC ground reference. 

Technology breakthroughs now allow channel-to-channel isolation to be accomplished 
effectively. Using an A/D per channel with a DC-DC converter for each A/D allows each 
signal input channel to be isolated from one another (see Figure 45). With this individual 
isolation per channel, each input channel can now “float” to its own ground reference. 
Separate channels are then effectively isolated from each other by the isolation barrier, up to 
±500 V for each channel on the DT8824 or ±1000 V for each channel on the DT8824-HV. Now 
any noise or common mode voltage to that level is eliminated from the system measurement, 
allowing pristine results from each sensor without any interaction from any other sensor.
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Figure 45: An A/D per channel and a DC-to-DC converter for each A/D provides channel-to-channel 
isolation, where each signal can float to its own ground reference.

Input channel return references are effectively separate instruments when the inputs are 
isolated. This individual isolation now allows the ground reference of each channel to 
measure at the level of this common mode voltage, up to ±500 V on the DT8824 and ±1000 V 
on the DT8826-HV. This capability allows some new application ideas to flourish.

Measurement of two signals, as shown in Figure 46, can now have essentially 3 separate 
ground references: each signal input (signal 0 and signal 1) has a separate return reference; 
additionally, the PC has a third ground reference. This scheme can be extended for many 
signal inputs, such as 48 inputs in a single small measurement box, for a total of 49 different 
ground references.
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Figure 46: When measuring two input signals with channel-to-channel isolation, three ground 
references are provided (signal 0, signal 1, and PC ground).

New Application Derived from Isolated Channels

A typical application of measuring 48 channels of varying voltages from sensors, such as 
batteries, thermocouples, RTDs pressure sensors, etc., often must use different instruments 
because of the various ranges needed. Standard ranges of ±10 V may handle some 
applications, but not others, to the required resolution and accuracy.

With isolation per channel, combinations of channels can be used to measure higher voltage 
ranges. Figure 47 shows a configuration of 2 separate channels “ganged up” to measure a 
signal of up to 20 V. Normally each input would measure ±10 V. But, by using two identical 
channels, a range of twice that level can be accommodated. The output readings of each A/D 
are then summed to give the very accurate result. This is possible because the isolation 
between channels allows the return of the first channel to “float up” to a level halfway 
between the input signal. This reflects the accurate impedance balance of each input, and the 
high common mode rejection of each stage.
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Figure 47: Because each floating signal input is isolated from each other, you can use two separate 
channels, normally each configured for ±10V, to measure a ±20V signal. Simply sum the result of 

each channel to get your result.

Summary

When you need the highest accuracy and the most flexibility from your measurement system, 
ensure that floating signal inputs are provided. This approach allows noise-free 
measurements in tough industrial settings. It also saves countless days of tracking down 
erroneous readings that inevitably result if these precautions are not taken from the project’s 
beginning.
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